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Introduction 

 

The world is replete with symmetry—not only the mathematical world, but our physical 

world as well.  And this symmetry, of course, has been studied mathematically for 

centuries.  Symmetry can be found in snowflakes, starfish, sand dollars and butterflies; in 

quilt patterns and automobile logos; in the rose windows of cathedrals in Europe, and in 

Islamic designs and tilings; and even in something as mundane as the courses of brick 

walls.  Because it is both mathematically rich and common to everyday life, the topic of 

symmetry appears in many types of college mathematics courses today, with titles like 

Mathematics and Art, Mathematics for Liberal Arts, The Mathematics of Non-Western 

Cultures and, of course, Geometry. 

 

When students first begin to study plane symmetry, they frequently have difficulty 

identifying the sources of the symmetry in a design in a rigorous way.  However, an 

interactive, computer-based experience with symmetry can help students to synthesize 

the concepts of symmetry, and quickly move toward independent recognition of 

symmetry in plane designs.  For building such interactive, computer-based worksheets, 

we find the dynamic mathematics system GeoGebra to be ideal.  Worksheets created with 

GeoGebra can be used for in-class demonstrations, as well as turned into applets that can 

be placed on the internet for students to use on their own.  And because GeoGebra is a 

free, multi-platform system, it is available to teachers everywhere. 

 

In this paper, we give step-by-step directions for creating GeoGebra worksheets for 

exploring symmetry in finite plane designs, as well as in strip patterns and plane tilings.  

Prior to following our instruction, however, we recommend that you take a few moments 

to actually interact with some of these worksheets, by visiting our web site, 

http://www.jcu.edu/math/ICTCM2011. 

 

 

A note about GeoGebra Tools and Object Properties 
 

Several of the tools discussed in this paper are not immediately visible when a new 

GeoGebra worksheet is opened.  The default toolbar is shown here: 
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Figure 1:  GeoGebra Toolbar 

 

Clicking on the small arrow in the bottom right corner of the “Slider” icon accesses the 

check box, text, and image tools, as well as the slider tool.   

 

 
Figure 2:  Additional tools under the Slider icon 

Likewise, clicking the small arrow in the bottom right corner of the “Reflection” icon 

gives access to the reflection, translation, and rotation tools.  Finally, the small arrow in 

the “Line” icon accesses the line and vector tools.  When a tool is selected, instructions 

for using it appear in the upper right area of the toolbar. 

 

      
 Figure 3:  Additional tools under the Reflection icon                 Figure 4:  Additional tools under the Line icon 
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The properties, such as name, size, and color, for any object can be altered by right 

clicking on the object and choosing Object Properties.  The properties available depend 

on the nature of the object.  If the default name that GeoGebra gives an object does not 

match the names given in this paper, you can change the names in the Basic tab of the 

Object Properties for that object.  Doing so will reduce confusion as we go through the 

process of creating several worksheets. 

 

 
 

Figure 5:  Sample Object Properties dialog box 

 

Symmetry of a finite design 
 

A finite plane design can have at most two types of symmetry – reflection and rotation.  

As a result, worksheets for exploring the symmetry of this type of design are easier to 

create and use than those for strip and tiling patterns. 

 

• Start by opening a new GeoGebra worksheet, deselecting the axes in the View 

menu, and using the Insert Image tool to insert a graphic image of a finite design 

from a file stored on your computer.  Change the name of the image to 

“originaldesign.”  

• Use the point tool to create a point A that will serve as the center of a rotation.   

• Use the slider tool to create a slider called “Angle” that will determine the angle 

of rotation.  Select the “Angle” option in the properties dialog box and choose the 

desired slider increment based on the nature of the design.  (Be sure to leave the 

degree symbol in the increment.)  Use the “slider” tab to change the length of the 

slider.  The default angle measurement in GeoGebra is degrees, which you can 

change to radians using the Options menu. 
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Figure 6:  Slider dialog box 

 

• Use the Rotate tool to rotate the design about point A, through the value of Angle:  

Click on the tool, and then click on the design followed by the point A.  Type the 

name Angle in the dialog box that appears.   

• Change the name of the resulting object to “rotateddesign.” 

• In order to be able to distinguish the rotated design from the original design, as 

well as to allow the original design to show through the rotated design, change the 

filling to less than 100% in the Style tab of the Object Properties for the rotated 

design.  You’ll have to experiment to find an appropriate level of filling based on 

your design. 

 

 
Figure 7:  Changing the filling of an object 

 

• Next, use the line tool to create a line L through points B and C that will serve as 

an axis of reflection. 

• Use the reflection tool to reflect the original design through the line L. 

• Change the name of this new object to “reflecteddesign.” 

• As before, change the shading (filling) of the reflected design to an appropriate 

value less than 100%. 
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Figure 8:  Worksheet in progress 

 

• The next step is to control what the user sees. 

o Use the Insert Text tool to create a text field instructing the user to place 

the center of rotation in the desired location and to set the angle of 

rotation.  Insert a separate text field with instructions on placing the axis of 

reflection.   

o Change the names of these text objects to “placecenter” and “placeline,” 

respectively. 

o Use the Check Box tool to create a check box with the title “Rotate about 

point A.”  Choose the rotated design from the drop-down menu.   

o This check box is associated with a Boolean variable.  Right click on the 

check box to change the name of this variable to a. 

o Create another check box with the title “Set the center of rotation.”  

Choose the point A, the slider for Angle, the “placecenter” text object, and 

the Boolean variable a from the drop-down menu. 

o Change the name of this new Boolean variable to b. 

o Check the appropriate box so that the rotated design is visible.  Under the 

Advanced tab of the Object Properties for the rotated design, adjust the 

“Condition to Show Object” so that the rotated design is visible only when 

the Boolean variables a and b are both true. Select the “and” symbol from 

the drop-down menu. 

 

 
Figure 9:  Setting Conditions to Show Object 

Rotated image 

Reflected 

image 

64



o Create a check box with the title “Reflect through line L.”  Choose the 

reflected design from the drop-down menu.  Name this Boolean variable c. 

o Create another check box with the title “Place an axis of reflection.”  From 

the drop-down menu, choose line L, points B and C, the “placeline” text 

object, and the Boolean variable c.  Name this new Boolean variable d. 

o Check the appropriate box so that the reflected design is visible.  Adjust 

the “Condition to Show Object” so that the reflected design is visible only 

when the Boolean variables c and d are both true.  

 

Finally, adjust the color and size of the various objects, using the Object Properties of 

each.  We like to use one color for all of the objects related to the rotation, and a different 

color for all of the objects related to the reflection.  Use the View menu to hide the 

Algebra view and the Input Bar, and use the Tools menu to customize the toolbar.  Save 

the worksheet as is for classroom use, or export it as a dynamic worksheet for use via the 

internet. 

 

 

 
Figure 10:  Completed worksheet 

 

Symmetry of an infinite design 
 

Strip and tiling patterns are infinite designs in the plane that allow for two additional 

types of symmetry in addition to reflection and rotation:  translation and glide reflection.  

In this section, we describe the creation of a worksheet for exploring the symmetries of a 

strip pattern.  These can, of course, be modified to create worksheets for exploring tiling 

patterns. 
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• Start by opening a new GeoGebra worksheet, deselecting the axes in the View 

menu, and using the Insert Image tool to insert a graphic image of a strip pattern 

from a file stored on your computer.  Name this image “originaldesign.”  If 

desired, create the tools for exploring reflections and rotations as in the section on 

finite designs in this paper. 

• Use the Vector tool to create a vector v from point D to point E. 

• Then use the Translate tool to translate the strip pattern by vector v.  Name the 

resulting object “translateddesign.” 

• Set the filling value of the translated design to an appropriate level below 100%. 

• Insert a text field with instructions on setting the length and direction of the 

translation vector v.  Name this text object “settranslation.” 

• Create a check box with the title “Translate design by vector v.”  Choose the 

translated design from the drop-down menu in the dialog box.  Name this Boolean 

variable e. 

• Create another check box with the title “Place a translation vector.”  From the 

drop-down menu, choose vector v, points D and E, the “settranslation” text object, 

and the Boolean variable e.  Name this new Boolean variable f. 

• Check the appropriate box so that the translated design is visible.  Adjust the 

“Condition to Show Object” so that the translated image is visible only when the 

Boolean variables e and f  are both true. 

 

A glide reflection is a composition of a reflection and a translation along the axis of the 

reflection.  Neither the reflection nor the translation need be a symmetry of the design.  

It’s possible to use the axis of reflection and the translation vector that already exist in the 

worksheet to create a glide reflection.  We prefer to create a new line and new vector, to 

reinforce the idea that a glide reflection is a single symmetry of the design. 

 

• Use the Line tool to create a line m through points F and G, and use the Vector 

tool to create a vector u on m, from point H to point I. 

• Change the Object Properties of u so that it is a different color and thickness than 

the line m. 

• Use the Translate tool to translate the strip pattern by vector u, and then use the 

Reflection Tool to reflect the result through the line m.  Name the translation by u 

“glide1” and the final result of the glide reflection “glidedesign.” 

• Right click on the “glide1” object, and uncheck “Show Object.” 

• Change the filling of the result of the glide reflection so that it can be 

distinguished from the original design. 

• Create a text field with instructions on positioning the line m, which is the axis of 

the glide reflection.  Create a separate text field with instructions on changing the 

length of the vector u.  Name these text objects “setglideaxis” and 

“setglidevector,” respectively. 

• Create a check box with the title “Perform glide reflection.”  Name the resulting 

Boolean variable g. 
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• Create a check box with the title “Set vector for glide reflection.”  Name the 

resulting Boolean variable h. 

• Create a check box with the title “Set axis for glide reflection.”  Choose the points 

F and G, the line m, the text object “setglideaxis,” and the Boolean variable h 

from the drop-down menu.  Name the resulting Boolean variable i. 

• Change the “Condition to Show Object” for points H and I, vector u, the text 

object “setglidevector” and the Boolean variable g so that these objects are visible 

only when the Boolean variables h and i are both true.   

• Change the “Condition to Show Object” for the “glidedesign” image so that the 

image is visible only when the Boolean variables g, h, and i are all true. 

 

Finally, adjust the color and size of the various objects.  Use the View menu to hide the 

Algebra view and the Input Bar, and use the Tools menu to customize the toolbar.  Save 

the worksheet as is for classroom use, or export it as a dynamic worksheet for use via the 

internet. 

 

 
Figure 11:  Completed worksheet for translations and glide reflections 

 

 

Changing the image in an existing worksheet 
 

Rather than starting from scratch to create a worksheet based on a different design, you 

can follow the steps below to change the design in an existing worksheet. 
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• Use the Insert Image tool to insert a new image into the worksheet.  Rename this 

image “originaldesign2.” 

• Click the appropriate check boxes to make the rotated, reflected, translated, and 

glide reflected versions of the design visible. 

• Reopen the Object Properties dialog box for the new design, click on the 

“rotateddesign” name in the frame at the left side of the window, and change its 

definition to be dependent on “originaldesign2.” 

 

 
Figure 12:  Changing definitions using Object Properties 

 

• Change the definitions of “translateddesign,” “reflecteddesign,” and “glide1” 

similarly.  You may have to close and then reopen the Object Properties box in 

order for these changes to take effect. 

• Delete the original design. 

• Move the new design to the desired location, and change its name to 

“originaldesign.” 

 

 

An optional enhancement 

 

Graphic images are, by their nature, rectangular.  If the design you wish to use does not 

extend to the edges of the rectangular box that forms the full image, you may wish to use 

a graphics editor to make the image’s background (which is probably white) transparent, 
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and export it as a .gif or .png file.  These image formats, which support background 

transparency, can be imported into GeoGebra worksheets.  Then, when your design is 

rotated or reflected, the transparency prevents the rectangular background from obscuring 

parts of the original design. 

 

 

Conclusion 

 

While the creation of the GeoGebra worksheets described in this paper does require some 

initial effort, remember that these worksheets are easily recycled into new worksheets 

with different images, as described in the section “Changing the image in an existing 

worksheet.”  And although it is fun to create your own symmetry explorations from 

scratch by following our instructions, a simple alternative is to start with one of our 

GeoGebra worksheets (available on our web site) and update it with your own image or 

customized instructions.  You’ll also have fun searching for symmetry in the world 

around you with digital camera in hand, or searching on the web (for example, in the 

Wikimedia Commons) for designs that you can share with your students, to help them 

discover the beauty of symmetry. 
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